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1 Übersicht
Im folgenden wird anhand einer vereinfachten Online-Banking-Anwendung schrittweise 
erklärt, wie mit der zen Platform eine Web-Anwendung erstellt werden kann. Die Anwendung 
soll in Anlehnung an gängige Online-Banking-Anwendungen dem Nutzer ermöglichen, 
Überweisungen zu tätigen, dadurch seinen Kontostand verändern und eine Liste der 
getätigten Überweisungen einzusehen. Die einzelnen Funktionalitäten werden schrittweise 
hinzugefügt und erweitert.

2 Installation
In den folgenden Abschnitten finden Sie eine detaillierte Beschreibung des Installationsvor-
gangs für die Entwicklungsumgebung Eclipse und den zen Developer Plugin zur Entwicklung 
von Anwendungen für die zen Platform.

2.1 Systemanforderungen
Um Eclipse und den zen Developer zu installieren, muss ein Java Standard Edition 
Development Kit (JDK) mit Version 1.4.x oder 5.0 vorhanden sein.

Sofern Sie noch keinen entsprechenden JDK installiert haben, können Sie unter

http://java.sun.com/javase/downloads/index.html

einen JDK für Ihr jeweiliges Betriebssystem gratis herunterladen und nach Anweisung in-
stallieren. 

2.2 Installation von Eclipse
Der zen Developer ist als Plugin in die freie Entwicklungsumgebung Eclipse integriert. 
Benötigt wird ein Eclipse-SDK ab Version 3.1. 

Für ältere Eclipse-Versionen (2.1.2, 2.1.3 oder Eclipse 3.0) kann man die Update-Site unter
http://www.zeos.de/support/download/

im Bereich Archiv herunterladen. Diese wird allerdings nicht mehr unterstützt. Sofern Sie 
trotzdem die veraltete Version installieren wollen, verwenden Sie bitte auch das dort 
angegebene Tutorial.

Installation

Sofern Sie die passende Eclipse-Version noch nicht installiert haben, laden Sie das entspre-
chende Paket des Eclipse-SDK für Ihr Betriebssystem gratis von:

http://www.eclipse.org/downloads/

herunter.

Das Eclipse-Paket wird generell ein einem komprimierten Format ohne eigenes 
Installationsprogramm ausgeliefert. Packen Sie die Inhalte in einem beliebigen Verzeichnis 
aus.

Start von Eclipse

Eclipse wird über die ausführbare Datei eclipse gestartet, die sich im Verzeichnis eclipse un-
terhalb des Installationspfades befindet.


Die GUI von Eclipse 3 unterscheidet sich in einigen Punkten von Eclipse 2. Im 
Tutorial werden noch einige Screenshots auf Basis von Eclipse 2 gezeigt. Die 
Unterschiede sind allerdings selbsterklärend.

2.3 Installation des zen Developer für Eclipse 3.1
Starten Sie nun bitte Eclipse. Wenn dies der allererste Eclipse-Start ist, wird zunächst der 
Workspace Launcher angezeigt. Hier können Sie angeben, wo Ihre Arbeitsdateien abgelegt 
werden sollen. Mit Use this as the default and do not ask again können Sie diese Einstellung 
als Standard festlegen. Anschließend sehen in der Eclipse-Workbench eine Welcome-Page 
mit Informationen über Eclipse. 

Um den zen Developer Plugin zu installieren, starten Sie den Installationsvorgang über 
Help->Software Updates->Find and Install. Es öffnet sich der Wizard Install/Update. Hier 
wählen Sie Search for new features to install.

Installation über die Update Site für Eclipse 3.1 (empfohlen)

Auf der folgenden Seite tragen Sie über den Button New Remote Site... die Update-Site für 
den zen Developer Plugin ein, von der der Plugin dann automatisch heruntergeladen und 
installiert wird.

➢ Geben Sie als Namen für die Update-Site zeos ein.

➢ Tragen Sie als URL die Adresse http://www.zeos.de/update/zen/ ein.
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➢ Beenden Sie den Dialog mit OK.

Die zeos Update-Site wird jetzt im Wizard angezeigt. Klappen Sie nun bitte den zeos-Knoten 
auf und lesen Sie dann weiter bei Start der Installation für Eclipse 3.1.

Installation als Download für Eclipse 3.1 (alternativ)

Wenn die Installation über die zeos Update-Site nicht möglich ist, laden Sie zuerst das In-
stallationsarchiv (ZIP) von

http://www.zeos.de/support/download/

auf Ihren Rechner herunter und speichern es in ein beliebiges Verzeichnis. Im 
Installationswizard wählen Sie dann über den Button New Archived Site das 
Installationsarchiv aus. Dieses können Sie nach der Installation wieder entfernen. 

Start der Installation für Eclipse 3.1

Im Installationswizard selektieren Sie nun unterhalb des Knotens zeos den Knoten 
zen Developer for Eclipse 3 (bzw. zenit3). Um den Installationsvorgang zu starten, klicken Sie 
auf den Button Next. Im Anschluß müssen Sie nur noch dem Lizenzvertrag zustimmen. Die 
Install Location auf der folgenden Seite belassen Sie auf dem Standard-Pfad. Mit Klick auf 
Finish wird Eclipse den zen Developer Plugin von der zeos Website laden (bzw. vom lokalen 
Rechner) und in den Verzeichnissen

• eclipse/features

• eclipse/plugins

speichern. Im Anschluss lassen Sie Eclipse auf Nachfrage einen Neustart ausführen.

Lizenz-Datei

Seit Eclipse 3 wird ein neu installierter Plugin nicht mehr automatisch aktiviert. Wählen Sie 
daher bitte manuell über Window->Open Perspective->Other den zen Developer aus.

Falls dies eine Erstinstallation ist, erinnert zunächst ein Dialog daran, dass der zen Platform 
license key noch nicht installiert wurde.

Kopieren Sie jetzt bitte die Lizenz-Datei, die Sie von uns erhalten haben, in das Eclipse-Unter-
verzeichnis 

plugins/de.zeos.zenit.lib.runtime_2.x.y

mit der höchsten Versionsnummer. x und y stehen dabei für die gerade installierte Version 
des zen Developers.

Sollten Sie noch keine Lizenz-Datei angefordert haben, so können Sie dies unter

http://www.zeos.de/support/download/license.php

nachholen.

Eclipse und der zen Developer Plugin sind damit fertig installiert. Die aktuellen Release Notes 
für diese Version finden Sie ebenso im Eclipse-Unterverzeichnis 
plugins/de.zeos.zenit.e3_2.x.y mit der höchsten Versionsnummer.

3 Vorbereitungen
Die zen Perspective sollte jetzt aktiviert sein. Welche Perspective jeweils aktiv ist, sehen Sie 
in der Shortcut Bar.

e3 Seit Eclipse 3 befindet sich die Shortcur Bar per Standard am oberen rechten 
Rand. Zudem zeigt sie für jedes Icon den Namen der Perspective. Wenn Sie mit 
der rechten Maustaste auf die Shortcur Bar klicken, können Sie diese über Dock 
On -> Left nach links setzen und die Namensanzeige abschalten (siehe Abbildung
1).

Der Name der aktiven Perspective wird in der Titelzeile angezeigt. Wenn Sie mit der Maus 
über einem Icon der Shortcut Bar stehen bleiben, wird der Name der jeweiligen Perspective 
auch als Tooltip eingeblendet. Welche Perspectives vordefiniert sind, sehen Sie im Menü 
Window->Open Perspective.
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
In einer Perspective werden Layout und Position aller Eclipse-Fenster (Editor & 
Views) definiert, die logisch zusammengehören. Indem Sie in einer Perspective 
die Anordnung des Editors/der Views ändern, Views aus- oder andere Views ein-
blenden, können Sie eine Perspective Ihren Wünschen nach anpassen. Über den 
Befehl Window->Reset Perspective kann die aktivierte Perspective jederzeit 
wieder auf den initialen Zustand zurückgesetzt werden.

zen Perspective

Die Modellierung einer zen-Anwendung findet immer in der zen Perspective statt. Eclipse mit 
aktivierter zen Perspective ist in Abbildung 2 dargestellt.

Am äußersten linken Rand sieht man die Shortcut Bar für die Umschaltung der Perspectives, 
die zen Perspective ist aktiv. Rechts davon ist der Package Explorer für die Navigation in-
nerhalb der Projekte, gerade ist nur Projekt „tutorial“ geöffnet. Rechts oben ist ein zen Editor 
„tutorial.zen“ geöffnet, auf dem Reiter daneben sieht man einen weiteren Editor 
„Banking.java“. Im rechten unteren Drittel sind alle Views des zen Developers positioniert, 
die Resource View ist gerade aktiv. Alle weiteren Views liegen momentan hinter der 
Resource View, unter anderem die Workflow View und die Action View.
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Abbildung 2
Übersicht über den zen Developer

Abbildung 1
Perspective-Icons in der Shortcut Bar am linken Rand, die 

zen Perspective ist aktiv.



e3 Seit Eclipse 3 sind die Reiter für die Aktivierung der Views (im rechten unteren 
Drittel) über den Views angeordnet. Die Position können Sie unter 
Window->Preferences im Bereich Workbench->Appearance konfigurieren.

Anlegen eines zen-Projekts für das Tutorial

Es existiert kein spezieller Projekt-Typ für zen-Anwendungen, stattdessen wird immer ein 
Standard Java-Projekt verwendet, da der Business Code einer zen-Anwendung auch in Java 
implementiert wird.

➢ Erstellen Sie ein neues Java-Projekt über den Wizard File->New Project...

➢ Als Typ wählen Sie Java Project und geben als Projekt-Namen tutorial an.

➢ Optional: Wenn Sie das Projekt professionell strukturieren wollen, sollten Sie für Java-
Sourcen ein eigenes Verzeichnis vorsehen. Wählen Sie hierzu im Bereich Project Layout 
die Option Create separate source and output folders.

auf Next und wählen Sie  den Button Add Folder... im Reiter Source. Hier legen Sie mit 
Create New Folder... ein neues Verzeichnis src an. Bestätigen Sie den Vorschlag von 
Eclipse, ein Verzeichnis bin für die kompilierten Klassen anzulegen (Ergebnis: siehe 
Abbildung 3).

e2 Unter Eclipse 2 war die Trennung von Source und Output Folder noch 
komplizierter (siehe Abbildung 3).

➢ Beenden Sie dann den Projekt-Wizard mit Finish. Eclipse schlägt vor, zur Java Perspective 
zu wechseln. Lehnen Sie dies ab, um weiterhin in der zen Perspective zu bleiben.

In dem erstellten Projekt können Sie nun zen-Anwendungen erstellen, was in den folgenden 
Kapiteln ausführlich beschrieben wird.

Eclipse-Workspace

Eclipse verwaltet alle Projekt-Ressourcen in einem sogenannten Workspace. Dazu wird 
automatisch ein Verzeichnis workspace angelegt. Sofern kein spezielles Verzeichnis explizit 
angegeben wurde, befindet es sich unter

• Windows: Im Installationsverzeichnis von Eclipse

• Linux/UNIX: Im working directory bzw. in dem Verzeichnis, aus dem Eclipse gestartet 
wurde

Das neu angelegte Projekt tutorial liegt ebenso im Workspace wie auch zusätzliche Tutorial-
Verzeichnisse, die automatisch bei der Installation des zen Developers angelegt wurden:

• zen-banking: Eine komplette Version des Tutorial-Projekts. Dies können Sie später über 
File->Import...->Existing Project into Workspace importieren und ausprobieren.
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Abbildung 3
Ausgefüllter Dialog: New Java Project



• zen-db: Hier legt die mitgelieferte, fertig konfigurierte Datenbank hsqldb ihre Daten ab. 
Diese dient dem zen Developer als Repository für die Modellierung als auch für die 
Business-Daten bei der Implementierung des Business Codes. Die Datenbank läuft im 
Hintergrund und muss nicht weiter beachtet werden.

4 Erstellen der ersten lauffähigen Anwendung
Im folgenden wird nun die Online-Banking-Anwendung in dem eben erstellten Projekt 
angelegt und dann Schritt für Schritt erweitert.

4.1 Anlegen der zen-Anwendung
Stellen Sie sicher, dass Sie sich in der zen Perspective befinden oder wechseln Sie über die 
Shortcut Bar in diese. Nun legen Sie eine neue zen-Anwendung mit Hilfe eines Wizards an.

➢ Selektieren Sie das Projekt tutorial.

➢ Wählen Sie im Menü File -> New den Typ zen Application. Daraufhin erscheint der 
zen Application Wizard. Als Projekt ist tutorial vorausgewählt.

Beim Anlegen der ersten zen-Anwendung in einem Java-Projekt muss noch die zen-
Konfiguration erzeugt werden.


Eine zen-Anwendung benötigt verschiedene Konfigurationsdateien. Diese müssen 
vorhanden sein, damit eine zen-Anwendung geöffnet, bearbeitet und ausgeführt 
werden kann. Informationen zu Details der zen-Konfiguration entnehmen Sie bitte 
dem zen Platform Developers Guide.

➢ Erstellen Sie eine initiale zen-Konfiguration, indem Sie auf den Button Create klicken.

➢ Ändern Sie den Namen der zen-Datei in tutorial.zen und wählen Sie als Repository den 
Eintrag zen.repository für Ihre Anwendung aus. Als Anwendungsnamen vergeben Sie 
ebenfalls tutorial (Ergebnis: siehe Abbildung 4)


Das Repository ist die Datenbank, in der die Modelldefinition einer zen-
Anwendung abgelegt wird. Der Eintrag zen.repository zeigt auf die mitgelieferte 
dateibasierte Datenbank hsqldb. Wie Sie stattdessen eine eigene Datenbank als 
Repository einrichten, entnehmen Sie bitte dem zen Platform Developers Guide.

➢ Wählen Sie Finish.

Daraufhin wird eine leere zen-Anwendung erzeugt und automatisch geöffnet. Jetzt sind alle 
Vorbereitungen abgeschlossen und die Tutorial-Anwendung kann erstellt werden. Dazu wird 
in den nächsten Schritten zuerst ein Datenmodell der Anwendung erstellt. Anschließend wird 
der Workflow der Anwendung modelliert.
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Abbildung 4
Ausgefüllter Dialog: New zen Application




Sie können die Durchführung des Tutorials jederzeit unterbrechen. Speichern Sie 
dazu die Anwendung wie gewohnt über das Menü File->Save. Einmal 
geschlossene  zen-Anwendungen öffnen Sie wie immer per Doppelklick oder im 
Kontext-Menü der entsprechenden Datei, in diesem Fall von tutorial.zen. Setzen 
Sie das Tutorial dann einfach an der gleichen Stelle fort, an der Sie aufgehört 
haben.

4.2 Definition des Datenmodells
Vorüberlegungen

Im ersten Schritt wird das Datenmodell angefertigt. Hierzu sind einige Vorüberlegungen 
nötig. In einer Banking-Anwendung werden z.B. folgende Objekte benötigt:

• Konto, z.B. mit Kontonummer und Saldo

• Kontoinhaber, z.B. mit Name und Anschrift

• Überweisungen, jeweils mit Betrag, Verwendungszweck etc.

In diesem Beispiel genügt zunächst die Anlage eines Kontos, bestehend aus Kontonummer 
und Saldo. Später wird das Datenmodell Schritt für Schritt erweitert werden.


Das Datenmodell einer zen-Anwendung ist ein hierarchisches Modell, das in der 
Data Model View in einer Baumansicht erstellt wird. Es enthält alle Daten, die in-
nerhalb der Anwendung zur Ein- und Ausgabe und als Parameter von 
Operationen verwendet werden.
Ausgehend von dem fest definierten Wurzelelement data wird das Modell auf 
Basis der elementaren Datenstrukturen Atom, Komposition (Composition) und 
Liste (List) definiert.
• Atom: Ein Atom ist ein Blatt des hierarchischen Datenmodells. Atome können 

Werte aufnehmen und bekommen einen Datentyp zugewiesen. Im Web-
Umfeld entsprechen Atome z.B. Ein- und Ausgabefeldern.

• Composition: Diese enthalten keine Werte, sondern dienen zur Gliederung 
unterschiedlicher Elemente. In Compositions können Atome, weitere 
Compositions und Lists zusammengefasst werden.

• List: Eine List wird auf einer Composition oder einem Atom definiert. Zur 
Laufzeit kann die List eine beliebige Menge von Elementen des definierten 
Typs aufnehmen.

Aus diesen Elementen lassen sich leicht verständliche, äußerst flexible und 
darüber hinaus leistungsfähige Datenmodelle erstellen.

Die grundlegenden Objekte werden als Atome definiert. Diese lassen sich über Compositions 
und Lists übersichtlich gliedern. Die in diesem Tutorial benötigten Datenelemente können 
alle durch die mitgelieferten Datentypen abgebildet werden, so dass keine Definition von 
eigenen Datentypen notwendig ist.


Die Modellierung einer zen-Anwendung findet zum großen Teil in den Views der 
zen Perspective statt. Diese befinden sich im rechten unteren Teil von Eclipse. Sie 
werden jeweils in den Vordergrund gebracht, indem man sie über den entspre-
chenden Karteireiter aktiviert oder über das Menü Window -> Show View 
auswählt.

Das Datenmodell wird in der Data Model View definiert. Aktivieren Sie diese jetzt bitte, um 
die Konto-Informationen zu modellieren.

Konto-Informationen

Für das Konto wird eine Composition account angelegt:

➢ Selektieren Sie das Wurzelelement data. Öffnen Sie das Kontextmenü mit der rechten 
Maustaste. Über Add Composition erzeugen Sie eine neue Composition. Diese wird 
automatisch unter dem Wurzelelement eingefügt.

➢ Klicken Sie anschließend doppelt auf den Namen der neuen Composition. Dieser wird 
damit editierbar. Benennen Sie die Composition in account um.

➢ Selektieren Sie nun die Composition account und legen Sie dort über das Kontextmenü 
ein neues Atom an. Geben Sie diesem anschließend den Namen number. Wählen Sie im 
rechten Teil der View den Datentyp Long für dieses Atom.
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➢ Legen Sie ein weiteres Atom unter der Composition account für den aktuellen 
Kontostand an. Dieses Atom nennen Sie balance und geben ihm den Datentyp Decimal 
with 2 digits precision.

Das Ergebnis ist in Abbildung 5 dargestellt. Das so definierte Datenmodell bildet die 
Grundlage für die folgenden Schritte, in denen der Workflow der Banking-Anwendung 
definiert wird.

4.3 Definition des Workflows
Jetzt wird ein einfacher Workflow definiert, der nur aus zwei Schritten besteht: Der Benutzer 
soll zur Anmeldung an die Banking-Anwendung seine Kontonummer eingeben. Zur Vereinfa-
chung wird in diesem Beispiel auf jegliche Autorisierung verzichtet. Auf der Folgeseite wird 
die Kontonummer dann wieder ausgegeben.


Der Workflow bestimmt das gesamte Ablaufverhalten einer zen-Anwendung. Er 
besteht aus den Zuständen (States Nodes) der Anwendung, die z.B. HTML-
Seiten oder Eingabe- bzw. Ausgabeschnittstellen entsprechen. Die State Nodes 
werden durch Übergänge (Transitions) miteinander verbunden. Der Wechsel 
von einem State in den nächsten kann nur durch eine Aktion (Action) ausgelöst 
werden, die dazu einem Übergang zugewiesen wird.

Die Definition des Workflows erfolgt visuell im zen Editor. Die genauen Eigenschaften der 
Workflow-Elemente können dabei in der Workflow View editiert werden. Bringen Sie diese 
hierzu in den Vordergrund.

State Nodes

➢ Zeichnen Sie im zen Editor einen State Node, indem Sie auf der Werkzeugleiste des 
zen Editors das State Node-Tool anklicken (siehe Abbildung 6) und dann an einer freien 
Stelle im Editor ein Rechteck aufziehen.

Anschließend geht der zen Editor automatisch wieder in den Select-Modus zurück.

➢ In der Workflow View ändern Sie den Namen dieses Nodes in start. Die Eingabe 
schließen Sie mit Return ab. Ebenso stellen Sie in der Workflow View als Gate 
defaultentry ein (Ergebnis: siehe Abbildung 7).
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Abbildung 5
Data Model View: Initiales Datenmodell

Abbildung 6
Erstellen eines State Nodes




Die Gate-Eigenschaft von State Nodes legt fest, wie ein Workflow von einem 
Benutzer betreten und verlassen werden kann
• default: normaler State Node innerhalb eines Workflows

• defaultentry: zentraler Standard-Einsprungpunkt in einen Workflow

• entry: (zusätzlicher) Einsprungpunkt in einen Workflow

• exit: Aussprungpunkt aus einem Workflow
Weitere Informationen entnehmen Sie bitte dem zen Platform Developers Guide

Der neue State Node wird vorübergehend als fehlerhaft markiert, weil er noch keine aus-
gehende Transition hat.

Dieser State Node stellt den Einsprungpunkt in den Workflow dar. Als nächstes folgt ein State 
Node, auf dem der Nutzer seine Kontonummer eingeben soll.

➢ Legen Sie diesen neuen State Node nun an und nennen Sie ihn login. Die Gate-
Eigenschaft wird diesmal auf default belassen.

➢ Als dritten State Node legen Sie nun noch menu an, ebenfalls ohne besondere Eigen-
schaften (Ergebnis: siehe Abbildung 8).

Transitionen

Die Übergänge von einem State Node zum nächsten werden mit dem Transition-Tool des 
zen Editors erstellt.

➢ Klicken Sie auf das Transition-Tool, der Mauszeiger bekommt nun ein Steckersymbol.
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Abbildung 7
Workflow View und zen Editor mit dem ersten State Node

Abbildung 8
zen Editor mit den ersten drei State Nodes



➢ Klicken Sie dann auf State Node start, um den Beginn der Transition festzulegen, und 
dann auf den State-Node login. Damit ist definiert, dass es einen Übergang von start 
nach login gibt, der z.B. durch eine Benutzer-Interaktion ausgelöst werden kann.

➢ Ebenso verbinden Sie den State Node login mit dem State Node menu (Ergebnis: siehe 
Abbildung 9).


Um Workflow-Elemente zu löschen, egal ob State Nodes, Decision Nodes oder 
Transitionen, markieren Sie das Element und löschen es dann über das Kontext-
menü, über Edit->Delete oder mit Hilfe der Taste Entf/Del. Generell kann jede 
Operation auch über Undo/Redo rückgängig gemacht oder wiederhergestellt 
werden.

Wenn die State Nodes verbunden werden, verschwinden automatisch ihre Warnungs- und 
Fehlermarkierungen.

4.4 Verbinden von Datenmodell und Workflow
Sie haben inzwischen ein Datenmodell und ein Workflowmodell erstellt. Nun werden Daten-
modell und Workflow miteinander verbunden, um zu definieren, in welchem State Node 
welche Daten angezeigt bzw. als Eingabe akzeptiert werden.

➢ Setzen Sie den zen Editor durch Anklicken des Select-Tools in den Select-Modus.

Auf der Seite login soll die Kontonummer als Eingabefeld angezeigt werden. Die 
Kontonummer wird also als Eingabe (In) und zur Anzeige als Ausgabe (Out) definiert. Hierzu 
aktivieren Sie die Data Model View.

➢ Selektieren Sie im zen Editor den State Node login. Dadurch können Sie die Ein- und 
Ausgabe-Elemente für diesen State Node modellieren.

➢ In der Data Model View klicken Sie dann auf das Element number und aktivieren Sie in 
dieser Zeile die Checkbox in den Spalten In und Out (Ergebnis: siehe Abbildung 10).
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Abbildung 9
Workflow im zen Editor mit Transitionen



Auf der Seite menu soll die eingegebene Kontonummer erscheinen, aber nicht als Eingabefeld 
behandelt werden.

➢ Selektieren Sie dazu jetzt den State Node menu und markieren Sie das Element number 
für diesen State Node diesmal nur als Out. (Ergebnis: siehe Abbildung 11).

➢ Speichern Sie das Modell jetzt über das Menü File->Save ab.

Sie haben nun alle Basisinformationen für einen ersten Start der Anwendung definiert. 
Eclipse aktiviert im Anschluss eventuell die Problems View. Diese wird vorerst nicht benötigt.

4.5 Hinweise für Entwicklung in anderen Sprachen
Die zen Platform unterstützt die Entwicklung von mehrsprachigen Anwendungen in vollem 
Umfang. Sämtliche Ressourcen für die Anzeige, z.B. Texte, Bildpfade, etc. können in 
verschiedenen Lokalisierungen hinterlegt werden. Eine Lokalisierung ist immer eine 
komplette Kombination aus Land und Sprache (z.B. ist Deutsch (Deutschland) eine von 
Deutsch (Österreich) verschiedene Lokalisierung). Wird die Anwendung dann zur Laufzeit in 
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Abbildung 10
Zuordnung von In und Out auf dem State Node „login“

Abbildung 11
Zuordnung der Out-Elemente auf dem State Node „menu“



einer bestimmten Lokalisierung ausgeführt, werden automatisch die passenden Ressourcen 
angezeigt. Die mitgelieferten Datentypen für Atome berücksichtigen ebenfalls die 
Lokalisierung, so dass Benutzereingaben zur Laufzeit in der entsprechenden Lokalisierung 
erfolgen können.


Zur Unterstützung der Entwicklung und Ausführung von mehrsprachigen 
Anwendungen werden im zen Developer folgende Sprach- und 
Ländereinstellungen unterschieden:
• Default Runtime Locale: Diese Einstellung bestimmt die Lokalisierung, in der 

die Anwendung standardmäßig abläuft. Die Default Runtime Locale wird in 
der Application View eingestellt. Für andere definierte Lokalisierungen muss 
die Anwendung dann mit speziellen Parametern aufgerufen werden. Nähere 
Informationen hierzu finden Sie im zen Platform Developers Guide.

• Entwicklungslocale: Diese Einstellung erleichtert während der Modellierung 
einer Anwendung die Eingabe von sprachspezifischen Ressourcen und Daten. 
Die Entwicklungslocale wird im zen Developer in der Toolbar am oberen Rand 
durchgeführt und hat keinen Einfluss auf das Laufzeitverhalten der erstellten 
Anwendung.

Für die korrekte Ausführung einer Anwendung müssen alle verwendeten Ressourcen in der 
gewünschten Lokalisierung vorliegen. Der zen Developer wird bereits mit einigen 
vorbereiteten Ressourcen ausgeliefert. Diese liegen in Deutsch (Deutschland) und 
Englisch (Vereinigte Staaten) vor. Wenn ihr Computer mit einer anderen Spracheinstellung 
konfiguriert ist, empfehlen wir Ihnen, eine der beiden mitgelieferten Lokalisierungen zu 
verwenden.

➢ Aktivieren Sie die Application View. Stellen Sie sicher, das hier Deutsch (Deutschland) 
oder Englisch (Vereinigte Staaten) als Default Runtime Locale ausgewählt ist.

➢ Stellen Sie den zen Developer mittels der Auswahlbox in der Toolbar auf die gleiche 
Locale (Ergebnis siehe Abbildung 12).

Wenn Sie Änderungen an der Default Runtime Locale vorgenommen haben, speichern Sie 
das Modell erneut.

4.6 Starten und Testen des Modells
Das Modell kann nun bereits ausgeführt werden. Hierzu muss nur noch ein so genannter 
Debug-Launch in Eclipse erstellt werden.

Debug-Launch

➢ Klicken Sie auf das Menü Run -> Debug... Im Debug-Fenster wählen Sie als 
Konfigurationstyp Java Application und klicken dann auf New. 
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Abbildung 12
Die Default Runtime Locale und die Entwicklungslocale (Auswahlbox am oberen Rand) sollten auf 

Deutsch (Deutschland) stehen



➢ Geben Sie der Konfiguration den Namen zen Tutorial. Als Projekt geben Sie tutorial 
an. 

➢ Wählen Sie die Option Include external jars when searching for a main class und klicken 
dann auf den Button Search... neben der Eingabezeile. Wählen Sie hier die Klasse 
TomcatStart (aus dem Archiv zenapi.jar) aus (Ergebnis: siehe Abbildung 13).

Start der zen-Anwendung

➢ Starten Sie anschließend die zen-Anwendung mit Debug.

Danach erscheint eine Dialogbox mit der Warnmeldung, dass die Anwendung noch 
Fehlermarkierungen enthält. Das liegt daran, dass bisher keine Behandlung von 
Anwendungsfehlern modelliert wurde. Dies ist für den ersten Start noch nicht nötig, wird aber 
später nachgeholt. Sie können die Warnmeldung also schließen und im Moment ignorieren.

Warten Sie nun einige Sekunden, bis der Debug-Prozess gestartet ist, dabei wird die Console 
View aktiviert. Wenn Sie in der Console View die Zeile

[TomcatStart]  Tomcat is up & running.

sehen, ist die zen Engine korrekt gestartet.

e3 Seit Eclipse 3 findet kein automatischer Wechsel zur Debug Perspective mehr 
statt. Erst wenn ein Breakpunkt erreicht wird, fragt Eclipse 3 nach, ob gewechselt 
werden soll. Zum echten Debugging muss man daher manuell in die Debug 
Perspective wechseln (siehe Abbildung 14).
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Abbildung 13
Ausgefüllter Dialog: Debug Launch



Die zen Engine läuft solange weiter, bis Sie diese explizit stoppen oder Eclipse beendet wird. 
Ob eine zen Engine läuft, sehen Sie auch in der Debug View links oben: Wenn dort unterhalb 
des Knotens zen Tutorial einzelne aktive Threads (nicht terminated) zu sehen sind, läuft die 
zen Engine (siehe Abbildung 15). Die Änderungen am Modell werden nach dem Speichern 
automatisch mit einer laufenden zen Engine abgeglichen, sie muss für den Test einer 
Modifikation daher nicht erneut gestartet werden.

Um die die zen Engine anzuhalten, klicken Sie in der Debug View einfach auf den Stop-Button 
(siehe Abbildung 15 links oben).

➢ Zum Testen der Anwendung klicken Sie nun mit der rechten Maustaste auf den State 
Node start und wählen Sie im Kontextmenü den Eintrag Launch Browser from „start“.... 
Dadurch wird ein Browser mit der Einstiegsseite dieser zen-Anwendung geöffnet.

Wenn Sie einen externen Browser manuell starten wollen, lautet die URL:

http://localhost:8989/zen/tutorial/zen.repository


Je nach Betriebssystem bringt sich Eclipse nach dem Start des Browsers eventuell 
selbständig wieder in den Vordergrund und überdeckt dadurch den soeben gest-
arteten Browser.

Test der zen-Anwendung

Sie sehen das Eingabefeld für die Kontonummer. Am oberen Rand befindet sich ein Submit-
Button mit der Aufschrift dummy_action (siehe Abbildung 16).


Die HTML-Ausgabe wird automatisch über ein XSL-Stylesheet erzeugt, ohne dass 
die HTML-Seiten per Hand definiert werden müssen. Hierfür wird standardmäßig 
ein generisches Stylesheet generic.xsl genutzt, das die Visualisierung anhand des 
Datenmodells erzeugt. Das Stylesheet wird in der Application View eingestellt 
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Abbildung 15
Debug View: Beenden des Debugprozesses

Abbildung 16
Browser: State Node „login“

Abbildung 14
Debug Perspective mit laufender zen Engine bzw. Tomcat

http://localhost:8989/zen/tutorial/zen.repository


und kann natürlich auch durch ein eigenes ersetzt werden.

➢ Geben Sie nun in das Feld „Hallo“ ein und senden Sie das Formular mit dem Submit-
Button dummy_action ab.

Das Feld wird rot unterlegt und die Fehlermeldung „Format ungültig“ erscheint. Das liegt 
daran, dass das Feld number mit dem Datentyp Long definiert wurde und somit nur Zahlen-
eingaben akzeptiert.


Die Fehlermeldungen von Datentypen können Sie selbstverständlich selbst de-
finieren. Die Verwaltung von Datentypen geschieht in der Datatype View, Fehler-
meldungen werden in der Resource View definiert.

➢ Geben Sie nun eine Zahl ein und senden das Formular erneut ab.

Nun wird in den State Node menu gewechselt, die von Ihnen eingegebene Zahl erscheint als 
einfache Textausgabe auf der nächsten Seite.

➢ Schließen Sie den Browser.

4.7 Anwendung zur Laufzeit ändern
Alle Änderungen am Anwendungsmodell können grundsätzlich zur Laufzeit erfolgen. Nach 
dem Speichern des Modells sollte dann jeweils ein neuer Browser gestartet werden.

Im folgenden werden nun die Eigenschaften des Datenmodells verändert und in die laufende 
Anwendung übertragen.

Pflichtfelder

➢ Starten Sie einen neuen Browser über das Kontextmenü auf dem State Node start. 
Lassen Sie diesmal das Eingabefeld leer und schicken Sie die Seite ab.

Es wird nun wieder in den State Node menu gewechselt, die Ausgabe für die Kontonummer 
number ist leer. Im nächsten Schritt soll verhindert werden, dass die Seite login ohne Angabe 
einer Kontonummer verlassen werden kann.

➢ Schließen Sie den Browser wieder.

Im Datenmodell wird hierzu das Feld number als Pflichtfeld deklariert. Wechseln Sie hierzu 
aus der Debug Perspective zurück in die zen Perspective und aktivieren Sie die Data Model 
View.

➢ Klicken Sie dort auf das Element number und aktivieren Sie die Checkbox mandatory auf 
der rechten Seite der View.

➢ In der jetzt aktiven Dropdownbox neben der Checkbox wählen Sie Eingabe 
unvollständig als Fehlermeldung.

Dieser Text erscheint jetzt als Fehlermeldung, wenn das Feld vom Benutzer nicht ausgefüllt 
wurde.

Änderungen zur Laufzeit übernehmen

➢ Speichern Sie das Modell ab.

Wenn die zen Engine noch läuft, erscheint daraufhin ein Dialog mit der Frage, ob die laufende 
Anwendung mit dem geänderten Datenmodell aktualisiert werden soll. Sonst starten Sie die 
zen Engine erneut über den Debug-Launch.

➢ Beantworten Sie die Frage mit „Yes“. Starten Sie einen neuen Browser über das Kontext-
menü auf dem State Node start. 

Der Beschreibungstext eines Pflichtfeldes wird vom generischen Stylesheet generic.xsl mit 
einem Stern (*) gekennzeichnet. Wenn Sie jetzt die Seite mit leerem Textfeld abschicken, 
wird das Feld rot unterlegt und die Fehlermeldung „Eingabe unvollständig“ ausgegeben.

5 Erweiterung der Anwendung
Die folgenden Erweiterungen können Sie jeweils bei laufender zen Engine vornehmen. Wie 
oben beschrieben, müssen Sie nach dem Abspeichern des Modells nur den Aktualisierungs-
dialog bestätigen, so dass die laufende Anwendung auf den aktuellen Stand gebracht wird. 

Wenn Sie die zen Engine zwischenzeitlich stoppen, müssen Sie den vorhin konfigurierten 
Debug-Launch mit Namen zen Tutorial erneut starten.

5.1 Hinzufügen von State-Ressourcen
Mit einer eindeutigen Überschrift für jede Formularseite wird die Orientierung in der 
Anwendung erleichtert. Hierzu wird nun für jeden State Node einen Seitentitel erstellt, der 
dann als Überschrift auf der jeweiligen HTML-Seite angezeigt wird.
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Wechseln Sie zurück zur zen Perspective und aktivieren Sie die Resource View. Hier werden 
z.B. Texte oder Bild-Links erstellt, mit denen Sie Workflow- und Daten-Elemente beschriften 
können.

➢ Klicken Sie auf den Reiter State, um eine Ressource für State Nodes zu erzeugen.

➢ Mit der rechten Maustaste klicken Sie in die noch leere Tabelle und wählen aus dem Kon-
textmenü Create.

➢ Für die neue Ressource headline geben Sie in der Spalte Value als Inhalt Bitte 
anmelden ein.

➢ Fügen Sie eine weitere headline-Ressource hinzu, diesmal mit dem Text Herzlich 
willkommen! (Ergebnis: siehe Abbildung 17).


Das generische Stylesheet generic.xsl nutzt State-Ressourcen mit dem Namen 
headline zum Zeichnen einer Überschrift. Für eine umfassendere 
Seitengestaltung können beliebige State-Ressourcen, z.B. Texte und Bilder, 
definiert und das Stylesheet darauf abgestimmt werden.

Aktivieren Sie nun wieder die Workflow View, um die neu erstellten Überschriften den jewei-
ligen State Nodes zuzuweisen.

➢ Selektieren Sie im zen Editor den State Node login.

➢ Wählen Sie in der Workflow View aus der Liste Available Resources die Überschrift Bitte 
anmelden aus und fügen Sie diese durch den Button mit dem Pfeil nach rechts oder durch 
Doppelklick der Liste der verwendeten Ressourcen hinzu (Ergebnis: siehe Abbildung 18). 
Eventuell müssen Sie dazu in der Workflow View nach unten scrollen.

➢ Analog weisen Sie dem State Node menu die Überschrift Herzlich willkommen! zu.

Nach dem Abspeichern werden die Überschriften automatisch in der Anwendung dargestellt.

17    zeos informatics – zen Platform 2.0 Tutorial

Abbildung 17
Resource View: Beschriftungen der State Nodes

Abbildung 18
Workflow View: Zuordnung zum State Node „login“



5.2 Erweitern des Workflows
Der Workflow wird nun um einen zusätzlichen Schritt erweitert, der es dem Nutzer 
ermöglichen soll, eine Überweisung zu tätigen. Stellen Sie sicher, dass Sie sich in der 
zen Perspective befinden oder wechseln Sie in diese.

➢ Zeichnen Sie im zen Editor einen neuen State Node und geben Sie ihm in der Workflow 
View den Namen transfer.

➢ Ziehen Sie vom State Node menu eine Transition auf den neuen State Node transfer. Auf 
diesem neuen State Node soll der Nutzer später die nötigen Daten für eine Überweisung 
eingeben können.

Actions

Um die einzelnen Übergänge besser auseinander halten zu können und später mit spe-
zialisierten Aktionen belegen zu können, werden nun Actions angelegt, die den einzelnen 
Transitionen zugewiesen werden. Aktivieren Sie hierzu die Action View (siehe Abbildung 19). 
Sie sehen eine Action mit dem Namen dummy_action, die bisher jeder Transition 
automatisch zugewiesen wurde.


Transitionen definieren die möglichen Übergänge zwischen den State Nodes. Der 
eigentliche Übergang von einem auf den nächsten State Node wird durch eine 
Action ausgelöst, im Web-Umfeld z.B. durch den Klick auf einen Button. Jede 
Transition bekommt eine Action zugewiesen.

Erstellen Sie nun spezialisierte Actions, die Sie später den einzelnen Transitionen zuweisen 
können.  Über die rechte Maustaste erreichen Sie in der Action-Tabelle das Kontextmenü 
Create, über das Sie eine neue Action anlegen können. Zuerst wird eine Action für die 
Benutzer-Anmeldung erstellt.

➢ Legen Sie eine neue Action an.

➢ Ändern Sie den automatisch erstellten Namen der Action in login.

➢ Um eine Überweisung zu erstellen, bereiten Sie analog eine Action transfer vor.

➢ Zur Ausführung der Überweisung wird eine weitere Action benötigt. Legen Sie hierfür die 
Action execute an.

➢ Zum Abbrechen der Überweisung fügen Sie außerdem die Action back hinzu, die später 
auch in anderen Transitionen verwendet werden kann. Als Besonderheit stellen Sie bei 
letzterer in der Spalte Type den Wert nonvalidating ein (Ergebnis: Abbildung 19).


Das Verhalten von Transitionen kann über den Action Type gesteuert werden. 
Unter anderem stehen folgende Möglichkeiten zur Auswahl:
• default: Normalfall. Eingehende Daten werden validiert.

• nonvalidating: Keine Datenvalidierung. Ein Formular kann auch bei 
unvollständigen oder fehlerhaften Benutzereingaben verlassen werden. Die 
Benutzereingaben werden gespeichert, stehen aber nicht für Operationen zur 
Verfügung. Es wird kein Fehler angezeigt. Business Rules werden nicht 
ausgeführt.

Weitere Informationen entnehmen Sie bitte dem zen Platform Developers Guide.

Die gerade angelegten Actions werden jetzt den passenden Transitionen zugewiesen.

➢ Selektieren Sie im zen Editor mit dem Select-Tool die Transition zwischen login und 
menu.

➢ Wählen Sie in der Workflow View aus der Action-Dropdownbox die Action login anstelle 
der dummy_action.
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Abbildung 19
Action View mit den ersten Actions



➢ Selektieren Sie nun die Verbindung zwischen menu und transfer und wählen Sie hierfür 
die Action transfer (Ergebnis: siehe Abbildung 20).

Nach Eingabe der Überweisungsdaten auf dem State Node transfer soll die Überweisung aus-
geführt werden. Danach soll wieder der State Node menu angezeigt werden, damit der 
Nutzer weitere Bankgeschäfte tätigen kann.

➢ Legen Sie hierzu eine Transition vom State Node transfer zum State Node menu an und 
weisen sie ihr die Action execute zu.

➢ Damit der Nutzer den Vorgang abbrechen kann, legen Sie eine weitere Transition von 
transfer nach menu an, diesmal aber mit der Action back (Ergebnis: siehe Abbildung
21).


Mit der Funktion Auto Layout können Sie ein automatisches Layout des Workflows 
erstellen lassen. Wählen Sie hierzu Zen -> Auto Layout oder den entsprechenden 
Button auf der Toolbar. Daraufhin werden alle Workflow-Elemente automatisch 
neu angeordnet.

Die letzten Änderungen können zwar schon ausgeführt werden, allerdings fehlt noch das Ein-
gabeformular für die Überweisungsdaten auf dem neuen State Node transfer.

5.3 Erweitern des Datenmodells
Damit der Nutzer auch die Daten seiner Überweisung eingeben kann, muss das Datenmodell 
erweitert werden. Aktivieren Sie hierzu wieder die Data Model View.

➢ Fügen Sie dem Element data, wie in Kapitel 4.2 Definition des Datenmodells beschrieben, 
zunächst eine Composition hinzu und ändern Sie deren Namen in transfer.

➢ Dieser Composition werden folgende Kinder zugeordnet:
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Abbildung 20
Zuordnung von Actions zu Transitions

Abbildung 21
Workflow mit den Actions „back“ und „execute“



Name Typ Datentyp

accountno Atom Long

bankcode Atom Long

amount Atom Decimal with 2 digits precision

text Atom String

date Atom Date

receipt Atom Boolean

Da eine Überweisung nur dann durchgeführt werden soll, wenn alle nötigen Pflichtdaten ein-
gegeben wurden, werden nun einige Atome als mandatory markiert.

➢ Klicken Sie hierzu auf die accountno und aktivieren Sie die Checkbox mandatory auf der 
rechten Seite der View.

➢ In der jetzt aktiven Dropdownbox neben der Checkbox wählen Sie Eingabe 
unvollständig als Fehlermeldung.

Dieser Text erscheint als Fehlermeldung, wenn das Feld vom Benutzer nicht ausgefüllt 
wurde. 

➢ Ebenso legen Sie die Atome bankcode, amount und date als mandatory fest und 
verwenden die gleiche Fehlermeldung.

Weitere Eigenschaften von Atomen

Zusätzlich können Sie die Länge von Eingabefeldern begrenzen. Hierzu geben Sie die ge-
wünschte Länge in dem Feld Max Value Length an.


Bei einer HTML-Ausgabe wird die Länge der Eingabefelder fest auf den Wert Max 
Value Length begrenzt. Die Angabe der Fehlermeldung ist für HTML 
strenggenommen nicht nötig, kann aber bei anderen Ausgabeformaten relevant 
sein und dort bei Überschreitung der Länge als Fehlerrückgabe verwendet 
werden.

➢ Weisen Sie z.B. den Atomen accountno die maximale Länge 10, bankcode die maximale 
Länge 8 und date die maximal Länge 10 zu. Wie bei der Markierung mit mandatory ak-
tiviert sich eine Dropdownbox neben dem Feld, aus der Sie jeweils die Fehlermeldung 
Eingabelänge überschritten auswählen.

Durch Angabe eines Default Value kann ein als mandatory gekennzeichnetes Atom mit 
einem konstanten Wert vorbelegt werden.

➢ Setzen Sie das Atom receipt auf mandatory, wählen Sie als Fehlermeldung Eingabe 
unvollständig und geben Sie als Default Value den String true ein.

Aus einem Boolean-Atom erzeugt das Stylesheet generic.xsl eine HTML-Checkbox. Durch 
Angabe des Default Value 'true' wird diese standardmäßig aktiviert (Ergebnis: siehe 
Abbildung 22).

Diese neu hinzugefügten Daten sollen nun das Eingabeformular für eine Überweisung auf 
dem State Node transfer bilden. Dazu müssen sie als Ein- und Ausgabe für diesen State Node 
definiert werden.

➢ Markieren Sie im zen Editor mit dem Select-Tool den State Node transfer und klicken 
Sie anschließend auf die Composition transfer in der Data Model View.

➢ Nun aktivieren Sie in der markierten Zeile die Checkbox in den Spalten In und Out. 
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Abbildung 22
Data Model View: Erweiterung des Datenmodells für Überweisungen



Durch das Setzten der In- bzw. Out- Eigenschaft auf Ebene der Composition werden automa-
tisch auch die Kinder der Composition als Ein- bzw. Ausgabe markiert.

Test

➢ Speichern Sie nun das Modell und testen Sie das Ergebnis.

➢ Starten Sie einen Browser über das Kontextmenü des State Nodes start.

Im Browser sind nun die Namen der neuen Actions auf den Buttons zu sehen, sowie die neu 
hinzugekommenen Elemente und State-Ressourcen (siehe Abbildung 24).

➢ Testen Sie auch die Funktionalität der Pflichtfeld-Eigenschaft (mandatory) und die 
automatische Validierung des Datumsformats auf dem Überweisungsformular.

Nach erfolgreichem Test wechseln Sie wieder zur zen Perspective.
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Abbildung 23
Browser: State Nodes „login“, „menu“ und „transfer“



5.4 Hinzufügen von Element- und Action-Ressourcen
In Formular-Anwendungen benötigen Eingabefelder normalerweise ein Label (Bezeichner) zur 
Beschreibung. Bisher wurden noch keine speziellen Labels definiert. Um trotzdem eine ver-
ständliche Ausgabe zu erzeugen, verwendet das Stylesheet generic.xsl für HTML-Eingabe-
elemente den jeweiligen Namen aus dem Modell. Um die Ausgabe zu optimieren, können Sie 
jedem Eingabefeld jedoch nach eigenen Vorstellungen spezielle sprachspezifische Labels 
bzw. jedem Button eine sprachspezifische Beschriftung zuweisen.

Aktivieren Sie die bereits bekannte Resource View. Im folgenden werden nun die Elemente 
aus der Datenstruktur und die Actions mit sprachspezifischen Labels beschriftet. Element-
Ressourcen werden im Reiter Element, Action-Ressourcen im Reiter Action angelegt.


Das Stylesheet generic.xsl gibt Element- und Action-Ressourcen mit dem Namen 
label als Labels bzw. Button-Beschriftung aus. Sie müssen also nur noch entspre-
chende Textinhalte nach Ihren Vorstellungen vergeben.

➢ Selektieren Sie den Reiter Element in der Resource View. Definieren Sie hier einige 
Element-Labels für das Überweisungsformular, z.B. mit den Values Kontonummer, 
Bankleitzahl, Betrag und Verwendungszweck.

➢ Aktivieren Sie die Data Model View und weisen Sie die gerade erstellten Labels den 
Elementen accountno, bankcode, amount und text zu. Dazu selektieren Sie jeweils das 
Element und können dann rechts die Zuweisung des Labels durchführen.

➢ Definieren Sie nun wiederum in der Resource View im Reiter Action einige Action-Labels 
(Button-Beschriftungen), z.B. mit den Values Zurück, Ausführen und Überweisung.

➢ Wechseln Sie nun in die Action View und weisen Sie die Button-Beschriftungen den 
Actions back, execute und transfer zu.
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Abbildung 24
Resource View: Beschriftungen für Elemente

Abbildung 25
Resource View: Beschriftungen für Actions



Nach dem Speichern und der Aktualisierung der laufenden Anwendung werden die entspre-
chenden Elemente und Actions beim nächsten Aufruf mit den von Ihnen definierten Labels 
und Button-Beschriftungen ausgegeben (siehe Abbildung 26).

5.5 Fehlerbehandlung
Erzeugung eines Timeouts


Bei einem Timeout wird eine inaktive Benutzer-Session nach einer gewissen Zeit 
gelöscht. Diese Zeit können Sie in der Konfigurationsdatei scfservice.xml ein-
stellen. Defaultmäßig ist der Timeout auf 750s eingestellt.
Weitere Informationen zur Konfigurationsdatei scfservice.xml entnehmen Sie 
bitte dem zen Platform Developers Guide.

Bei Anwendungsfehlern oder bei Timeouts nimmt die zen Engine einen Fehlerzustand ein. 
Um dies zu testen, können Sie einen Timeout folgendermaßen simulieren, statt auf ihn zu 
warten:

➢ Starten Sie bei laufender zen Engine ihren Browser über das Kontextmenü auf dem State 
Node start.

Der State Node login wird angezeigt.

➢ Nun stoppen Sie die zen Engine in der Debug Perspective (siehe auch Kapitel   4.6   Starten
und Testen des Modells). Schließen Sie den geöffneten Browser nicht! Starten Sie die 
zen Engine nun wieder über Run->Debug History->zen Tutorial. 

Damit wurden alle Session-Informationen gelöscht. Der geöffnete Browser referenziert aber 
noch die alte Session.

➢ Schicken Sie nun die im geöffneten Browser angezeigte Seite mit login ab.

Die zen Engine kann nach dem Neustart die Session der abgeschickten Seite zwangsläufig 
nicht mehr zuordnen. Damit haben Sie einen Timeout im Schnellverfahren simuliert. Im 
Browser erscheint eine Fehlermeldung, die im Stylesheet generic.xsl definiert ist (siehe 
Abbildung 27).

Spezielle State Nodes: builtin:error / builtin:timeout

Diese einfache Standard-Fehlermeldung ist für eine echte Anwendung in der Regel nicht aus-
reichend. Sie können daher selbst angepasste Fehler- und Timeout-Zustände erstellen, um 
das Fehlerverhalten nach Ihren Wünschen zu bestimmen. Wechseln Sie hierzu in die 
zen Perspective.
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Abbildung 26
Browser: State Node „transfer“ mit Beschriftungen

Abbildung 27
Browser: Standard-Fehlermeldung bei Timeout



➢ Erstellen Sie im zen Editor zwei neue State Nodes, die Sie in der Workflow View der 
zen Perspective in builtin:error und builtin:timeout umbenennen. Achten Sie auf 
die korrekte Schreibweise, insbesondere die Groß-/Kleinschreibung.

Damit verschwinden auch die Fehler aus der Task View. Bei einem erneuten Start des Debug-
Vorgangs wird nun auch keine Dialogmeldung mehr erscheinen, die Sie auf das 
unvollständige Modell hinweist.


Die State Nodes builtin:error und builtin:timeout werden spontan aktiviert, wenn 
die zen Engine einen Anwendungsfehler oder Timeout entdeckt. Sie benötigen im 
Gegensatz zu gewöhnlichen State Nodes keine eingehenden Transitionen. Mit 
ausgehenden Transitionen kann dem Nutzer jedoch wieder ein definierter 
Einsprung in den Workflow ermöglicht werden.

➢ Ziehen Sie jeweils eine Transition von den beiden neuen State Nodes zum State Node 
login, damit der Nutzer nach einem Fehler oder Timeout den Workflow wieder von vorne 
beginnen kann.

➢ Weisen Sie diesen Transitionen in der Workflow View die Action back zu (Ergebnis: siehe 
Abbildung 28).

➢ Aktivieren Sie die Resource View und erstellen Sie im Reiter State zwei State Node-Über-
schriften mit dem Namen headline und den Values Ein Fehler ist aufgetreten. 
Bitte loggen Sie sich erneut ein bzw. Ein Timeout ist aufgetreten. Bitte 
loggen Sie sich erneut ein.

➢ Weisen Sie diese Überschriften in der Workflow View den soeben erstellten State Nodes 
zu.

➢ Speichern und testen Sie die Anwendung, indem Sie wie oben beschrieben erneut einen 
künstlichen Timeout erzeugen.

Nun wechselt die zen Engine in den soeben definierten Timeout-Zustand. Von hier aus kann 
der Nutzer dann wieder definiert zur Login-Maske wechseln (siehe Abbildung 29).


Falls sie das Fehler- oder Timeout-Verhalten noch feiner kontrollieren wollen, 
können Sie statt der globalen State Nodes builtin:error und builtin:timeout auch 
Actions gleichen Namens erstellen. Mit diesen Actions können Sie dann spezielle 
Fehlertransitionen auf einzelnen State Nodes definieren. Weitere Informationen 
zu diesem Thema finden Sie im zen Platform Developers Guide
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Abbildung 28
State Nodes und Transitions zur Fehlerbehandlung

Abbildung 29
Browser: State Node „bultin:timeout“



6 Programmierung der Geschäftslogik
Die zen-Anwendung wurde bis jetzt ohne eine einzige Zeile Business-Code erstellt. Die tat-
sächliche Durchführung einer Überweisung bedarf aber natürlich einer konkreten, program-
mierten Geschäftslogik.

Die Geschäftslogik von zen-Anwendungen wird generell in Java programmiert. Java-Methoden 
werden als sogenannte Operations in das Anwendungsmodell integriert und mit dem Daten- 
und Workflowmodell verknüpft. Sie haben dabei vollen Zugriff auf das gesamte Datenmodell 
und die Service-API der zen Platform. Für jede Java-Methode wird eine eigene Operation 
modelliert, die die Verbindung zwischen Java-Methode und Modell herstellt.


Eclipse unterstützt Java-Code-Änderungen zum Teil bei laufender zen Engine. Nur 
wenn Eclipse Sie beim Speichern von Java-Code-Änderungen darauf hinweist, 
dass das Hot Code Replacement fehlgeschlagen ist, müssen Sie zum Testen Ihrer 
Änderungen die zen Engine anhalten und neu starten.

Für die Geschäftslogik erstellen Sie in der zen Perspective zunächst eine neue Java-Klasse:

➢ Klicken Sie mit der rechten Maustaste im Package Explorer auf das Projekt tutorial.

➢ Wählen Sie im Kontextmenü New -> Class. Geben Sie als Namen Banking ein, die 
weiteren Eigenschaften können Sie auf den vorgegeben Werten belassen  (Ergebnis: 
siehe Abbildung 30).

Eclipse legt mit Finish eine Java-Klasse nach Ihren Vorgaben an und öffnet sie automatisch im 
Java-Editor. Dort wird im weiteren die Geschäftslogik der Anwendung implementiert.


Die zen Platform unterscheidet zwischen Workflow Operations und Business 
Rules:
• Workflow Operations: Workflow Operations und Decisions werden vom 

Entwickler an bestimmte Workflowelemente, z.B. an Nodes, Transitions oder 
Actions gekoppelt. Dadurch wird der Ausführungszeitpunkt bestimmt.

• Business Rules: Computation und Validation Rules werden nur mit dem Da-
tenmodell verknüpft und werden immer dann automatisch ausgeführt, wenn 
die verknüpften Datenelemente als (geänderte) Eingabedaten vorliegen.

6.1 Decisions
Der Kontrollfluss einer zen-Anwendung kann nicht immer statisch festgelegt werden. Oft 
muss dynamisch entschieden werden, wie der Kontrollfluss fortgesetzt wird. Dazu verwendet 
die zen Platform Decisions.


State Nodes in einem Workflow werden mit Transitions verbunden. Diese 
definieren statisch die möglichen Übergänge zwischen den State Nodes. Eine 
Transition kann sich mit einem Decision Node jedoch auffächern. Abhängig von 

25    zeos informatics – zen Platform 2.0 Tutorial

Abbildung 30
Ausgefüllter Dialog: New Java Class „Banking“



entwicklerdefinierten Dateninhalten wird dann dynamisch zur Laufzeit einer von 
mehreren möglichen Folge-State-Nodes ausgewählt.

Die Banking-Anwendung wird nun so erweitert, dass der Nutzer nach seiner Überweisung 
eine optionale Bestätigung erhält. Der Nutzer soll dies durch Aktivieren der Checkbox receipt 
steuern. Hierzu wird ein Decision Node für die Verzweigung erstellt und eine Decision 
Operation für die Entscheidung implementiert. Zusätzlich wird ein weiterer State Node für die 
Überweisungsbestätigung angelegt und der bisherige Workflow an die Decision angepasst.

Wechseln Sie jetzt wieder in die zen Perspective, falls diese nicht schon aktiv ist, und 
aktivieren Sie den zen Editor.

Modell erweitern

➢ Zuerst fügen Sie im zen Editor den State Node für die Anzeige der Bestätigung ein und 
nennen ihn confirmation.

➢ Wählen Sie aus der Werkzeugleiste das Tool für Decision Nodes und zeichnen Sie einen 
Decision Node auf der Zeichenfläche.

Der Decision Node wird solange als fehlerhaft dargestellt, bis ihm später eine Decision 
Operation zugeordnet wird, die dann über den weiteren Verlauf des Workflows entscheidet.

➢ Geben Sie dem Decision Node in der Workflow View den Namen with-receipt.

➢ Wechseln Sie in den Select-Modus und suchen Sie diejenige Transition von transfer 
nach menu, die mit der Action execute gekennzeichnet ist.

➢ Diese Transition wird nun über den neuen Decision Node umgeleitet. Markieren Sie die 
Transition und ziehen Sie das Ende mit der Pfeilspitze bei gedrückter linker Maustaste auf 
den Decision Node.

➢ Zeichnen Sie nun neue Transitionen von with-receipt zu menu sowie von with-receipt 
zu confirmation ein. Diese beiden Transitionen definieren die möglichen Verzweigungen 
des Workflows.

Somit führt die Ausführung einer Überweisung jetzt nicht mehr direkt zurück zum Menü, 
sondern zuerst zum Decision Node, der den weiteren Ablauf bestimmt. Der Decision Node 
kann entweder wie bisher zum State Node menu verzweigen oder den Umweg über die Über-
weisungsbestätigung confirmation nehmen.

➢ Zeichnen Sie eine weitere Transition von confirmation zu menu und weisen sie ihr in der 
Workflow View die Action back zu (Ergebnis: siehe Abbildung 31).

Java-Methode


Eine Decision Operation entscheidet, welche ausgehende Transition eines 
Decision Nodes verfolgt wird. Die nötigen Entscheidungskriterien werden über die 
Eingabeparameter der Decision Operation definiert.

Nun benötigen Sie nur noch eine Decision Operation, die zur Laufzeit den weiteren Verlauf 
des Workflows bestimmt. Die Java-Methode für die Decision Operation ist denkbar einfach: 
Sie liefert anhand des Atoms receipt einen festen String zurück.
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Abbildung 31
Workflow mit Decision Node



➢ Fügen Sie die in die zuvor erstellte Java-Klasse Banking folgende Methode ein:

public static String confirm(Boolean b) {
if (b.booleanValue())
return "yes";

else
return "no";

}

Speichern Sie die geänderte Klasse anschließend. Eclipse kompiliert den Quelltext 
automatisch beim Speichern, der Compilerlauf muss also nicht manuell gestartet werden.

Im nächsten Schritt wird der Business-Code nun mit dem Modell verknüpft. Somit wird fest-
gelegt, wann die gerade hinzugefügte Methode aufgerufen wird und mit welchen Daten sie 
dabei befüllt werden soll. Aktivieren Sie hierzu die Business Logic View.

➢ Klicken Sie auf den Reiter Decisions, öffnen Sie mit der rechten Maustaste im leeren Be-
reich darunter das Kontextmenü und wählen Sie New...

➢ Im daraufhin erscheinenden Dialog geben Sie als Description der Operation den Text 
Beleg erforderlich? an und wählen über den Button Browse... als implementierende 
Klasse die gerade erstellte Klasse Banking.

➢ In der Dropdownbox für die Methode können Sie nun die Methode confirm auswählen 
(Ergebnis: siehe Abbildung 32). Legen Sie die Operation dann mit Finish an.

Die neue Operation wird nach dem Anlegen erst noch als fehlerhaft dargestellt, weil bisher 
keine Argumente zugewiesen wurden.

Dies wird im nächsten Schritt nachgeholt.
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Abbildung 32
Ausgefüllter Dialog: New Operation „confirm“

Abbildung 33
Business Logic View: Zuordnung von Argumenten zu einer Operation



➢ Klappen Sie im Bereich Arguments der Business Logic View den Datenmodellbaum soweit 
auf, bis Sie alle Kinder der Composition transfer sehen.

➢ Klicken Sie dann auf das Atom receipt und anschließend auf den oberen Button mit dem 
Pfeil nach rechts zwischen Datenmodellbaum und Argumenten (Ergebnis: siehe 
Abbildung 33).

Die Java-Methode ist damit mit dem Datenmodell korrekt verbunden, die Fehlermarkierung 
verschwindet. Nun muss diese Decision Operation nur noch dem Decision Node im Workflow 
zugeordnet werden.

➢ Aktivieren Sie hierzu die Workflow View und selektieren Sie im zen Editor den Decision 
Node with-receipt.

➢ Klappen Sie in der Workflow View den Baum mit der Klassenhierarchie vollständig auf 
und selektieren Sie die gerade erstellte Decision Operation Beleg erforderlich?. 
(Siehe Abbildung 34)

Jetzt werden nur noch die Rückgabewerte der Decision Operation mit den passenden ausge-
henden Transitionen verknüpft, um den weiteren Ablauf nach dem Decision Node 
festzulegen.

➢ Klicken Sie dazu auf die Transition von with-receipt zu menu und geben dann in der 
Workflow View als Return Value der Transition den Wert no ein. Achten Sie darauf das die 
Schreibweise exakt – auch in der Groß-/Kleinschreibung- dem Rückgabewert der Java-
Methode entspricht (siehe Abbildung 35).

➢ Klicken Sie dann auf die Transition von with-receipt zu confirmation und geben Sie 
hier als Return Value den Wert yes ein.
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Abbildung 34
Zuordnung der Decision Operation zum Decision Node



Daraufhin verschwindet automatisch die Fehlermarkierung des Decision Nodes.

Wird der Decision Node nun betreten, wird die soeben implementierte Decision Operation mit 
dem Boolean-Atom receipt aufgerufen. Die Decision Operation entscheidet dann über den 
weiteren Verlauf der Transition: Es wird diejenige Transition ausgewählt, deren zugeordneter 
Return Value mit dem Rückgabewert der Decision Operation übereinstimmt.

➢ Auf dem State Node confirmation werden bisher noch keine Daten angezeigt. Um das zu 
korrigieren, öffnen Sie die Data Model View, selektieren den State Node confirmation und 
aktivieren für die Composition transfer die Checkbox in der Spalte Out.

Die Anzeige der Überweisungsbestätigung können Sie jetzt sichern und testen (siehe 
Abbildung 36).

6.2 Workflow Operations
Um zu bestimmten Zeitpunkten im Workflow-Verlauf Operationen auszuführen, verwendet 
man Workflow Operations. Im Rahmen der Banking-Anwendung soll z.B. bei Ausführung der 
Überweisung der Überweisungsbetrag vom Saldo des Kontos abgezogen werden. Hierzu ist 
noch eine kleine Vorarbeit nötig.
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Abbildung 36
Browser: State Node „confirmation“

Abbildung 35
Zuweisen des Return Value zur Transition



Kontostand füllen

Da keine Kontoverwaltung implementiert ist, ist der Saldo zunächst leer. Für das Tutorial wird 
er nun mit einem zufälligen Wert zwischen 100 und 1000 vorbelegt.

➢ Erstellen Sie folgende Methode in der Klasse Banking:

public static Float generateFloat() {
return new Float(100.0 + Math.random() * 900.0);

}

Speichern Sie die Java-Klasse. Für diese Methode wird nun in der Business Logic View eine 
Operation angelegt.

➢ Wechseln Sie hierzu in der Business Logic View auf den Reiter Workflow, öffnen Sie das 
Kontextmenü über die rechte Maustaste und wählen Sie New... aus.

➢ Geben Sie der Operation die Beschreibung erzeuge zufälligen Saldo und wählen Sie 
die soeben erstellte Methode aus der Klasse Banking aus. Legen Sie die Operation dann 
mit Finish an.

Nun werden rechts in der Business Logic View wieder die Argumente zugeordnet. Da diese 
Methode keine Eingabe-Argumente benötigt, wird nur der Return Value definiert, der den 
zufälligen Saldo vorgibt.

➢ Weisen Sie hierzu der Operation das Atom balance (unterhalb der Composition account) 
diesmal mit dem unteren Pfeil nach rechts als Return Value zu. Die Fehlermarkierung 
verschwindet. Nach dem Aufruf der Operation wird das Ergebnis nun automatisch als 
Saldo in die Sessiondaten übernommen.

Die Operation soll jedesmal direkt nach dem Login den zufälligen Saldo berechnen. Dazu wird 
sie der Transition von login nach menu hinzugefügt.

➢ Aktivieren Sie die Workflow View und markieren Sie die Transition von login nach menu.

➢ Klappen Sie in der Workflow View die Klassenhierarchie auf und weisen Sie die soeben 
definierte Operation durch Klick auf den Pfeil nach rechts der Transition zu. Die Operation 
wird dadurch beim Übergang automatisch ausgeführt.

➢ Damit der Saldo angezeigt wird, markieren Sie in der Data Model View für den State 
Node menu das Atom balance mit der Eigenschaft Out.

Überweisungsbetrag vom Kontostand abbuchen

➢ Jetzt können Sie die eigentliche Methode zur Abbuchung des Überweisungsbetrags vom 
Saldo implementieren.

public static Float substract(Float balance, Float amount) {
return new Float(balance.floatValue() - amount.floatValue());

}

➢ Speichern Sie die Java-Klasse.

➢ Definieren Sie diese Methode nun in der Business Logic View über das Kontentmenü 
New... als Workflow Operation mit der Beschreibung Betrag auf Saldo buchen. Legen 
Sie die Operation dann mit Finish an.

➢ Als Eingabeargumente weisen Sie der Operation die Atome balance (unterhalb der 
Composition account) und amount (unterhalb der Composition transfer) mit dem oberen 
Pfeil nach rechts zu. Achten Sie auf die Reihenfolge, da diese natürlich mit den 
Methodenparametern übereinstimmen muss.

➢ Als Return Value weisen Sie der Operation ebenso das Atom balance zu – dazu benutzen 
Sie den unteren Pfeil nach rechts.

➢ Weisen Sie diese Operation dann in der Workflow View der Transition von transfer nach 
with-receipt zu.

Nun wird bei jeder Überweisung der angegebene Betrag automatisch vom Kontostand abge-
bucht.
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6.3 Business Rules
Die bisher implementierten Operationen sind mit dem Workflow einer zen-Anwendung ver-
bunden und werden immer während der Abarbeitung des jeweiligen Workflowschrittes aus-
geführt.

Business Rules stellen hingegen das geschäftliche Regelwerk einer Anwendung dar und sind 
unabhängig von deren Kontrollfluss. Sie sind nur von den Anwendungsdaten abhängig und 
werden auch nur bei neuen oder geänderten Daten gefeuert.


Mit Business Rules definiert die zen Platform Operationen, die nur von Daten 
abhängig sind. Sie werden nicht mit dem Workflow verbunden, sondern automa-
tisch immer dann ausgeführt, wenn die damit verknüpften Daten vom Nutzer ein-
gegeben oder geändert werden. Business Rules werden unterteilt in:
• Computation Rules: Business Rules zur Berechnung oder Veränderung von 

Daten. Die Rückgabe definiert die veränderten Datenelemente und kann 
dadurch weitere Business Rules auslösen.

• Validation Rules: Business Rules zur Validierung von Daten. Diese dürfen 
keine Daten modifizieren.

Computation Rules

Als Beispiel soll in einer Computation Rule der Überweisungstext automatisch in Groß-
buchstaben verwandelt werden.

➢ Implementieren Sie dazu folgende Java-Methode:

public static String toUpperCase(String s) {
return s.toUpperCase();

}

➢ Speichern Sie die Java-Klasse. 

➢ Erstellen Sie für diese Java-Methode nun eine neue Computation Rule im Reiter 
Computation der Business Logic View über das Kontextmenü New.... Als Beschreibung 
geben Sie Überweisungstext in Großbuchstaben an. Erstellen Sie die Operation dann 
mit Finish. 

➢ Weisen Sie der Operation schließlich als Eingabe-Argument und als Return Value das 
Atom text zu.

Diese Computation Rule wird von der zen Engine immer dann automatisch aufgerufen, wenn 
sich der Überweisungstext geändert hat.

Testen Sie die Computation Rule, indem Sie nach den Speichern eine Überweisung mit 
Bestätigung durchführen. Der Überweisungstext erscheint auf der Bestätigungsseite jetzt 
immer in Großbuchstaben.

Validation Rules

Mit Validation Rules können geschäftliche Validierungsregeln realisiert werden. Sie werden 
nach Abarbeitung der Computation Rules ausgeführt.

In der Beispielanwendung wird derzeit noch nicht überprüft, ob das eingegebene 
Ausführungsdatum von Überweisungen in der Vergangenheit liegt. Im folgenden wird nun 
eine Geschäftsregel erstellt, um ein abgelaufenes Datum zu verbieten. In diesem Fall soll 
dem Nutzer eine Fehlermeldung angezeigt werden.

➢ Implementieren Sie in der Klasse Banking dazu folgende Methode:

...
import java.util.Date;
import de.zeos.zen.api.core.ValidationRuleException;
...

public static void checkDate(Date d, Date today) throws ValidationRuleException {
if (d.before(today))
throw new ValidationRuleException();

}

Die Verletzung einer Validation Rule wird durch eine ValidationRuleException signalisiert. Der 
Nutzer bekommt dann automatisch eine Fehlermeldung angezeigt, die als Operation-
Ressource erstellt und der Validation Rule zugewiesen wird.

➢ Aktivieren Sie die dazu Resource View und klicken Sie dort auf den Reiter Operation 
Error.

➢ Erstellen Sie über das Kontextmenü eine neue Ressource. Geben Sie als Value ein: Das 
Überweisungsdatum darf nicht in der Vergangenheit liegen (Ergebnis: siehe 
Abbildung 37).

➢ Erstellen Sie nun die Validation Rule in der Business Logic View, indem Sie auf den Reiter 
Validation klicken und über das Kontextmenü eine neue Operation für die Validation Rule 
checkDate anlegen. Geben Sie als Description den Text prüfe Überweisungsdatum ein.
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➢ Weisen Sie der Operation das Element date als erstes Argument und die Field Function 
today als zweites Argument zu (Ergebnis: siehe Abbildung 38). Field Functions finden Sie 
in der Business Logic View im Abschnitt Arguments/Return Values. Field Functions sind 
vorgegebene Funktionen, die von der zen Engine zur Verfügung gestellt werden; today 
liefert als sehr einfaches Beispiel einer Field Function den aktuellen Tag um Mitternacht 
zurück, um Datumsvergleiche zu vereinfachen.

Nun muss der Validation Rule noch der vorbereitete Operation Error als Fehlermeldung zuge-
wiesen werden:

➢ Bei weiterhin selektierter Operation prüfe Überweisungsdatum wählen Sie die neue 
Fehlermeldung aus der Liste Available Resources aus und fügen diese der Liste Chosen 
Resources hinzu.

Wie bei Computation Rules ist auch hier keine Zuweisung zum Workflow nötig, da die 
Validation Rule automatisch ausgeführt wird, sobald sich die Werte ihrer Argumente ändern.

Gibt der Nutzer nun bei der Überweisung ein Datum in der Vergangenheit an, wird ihm 
automatisch die modellierte Fehlermeldung angezeigt.


Soll eine einzige Validation Rule mehrere verschiedene Fehlermeldungen 
anzeigen können, werden der Validation Rule mehrere Operation-Ressourcen mit 
unterschiedlichem Namen zugeordnet. Der ValidationRuleException wird dann 
der Name derjenigen Operation-Ressource mitgegeben, die angezeigt werden 
soll.
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Abbildung 37
Resource View: Fehlertext für Validation Rule

Abbildung 38
Business Logic View: Zuordnung einer Field Function als Argument



7 Einfache Persistenz mit JDBC
Bisher wurden alle Daten der Anwendung dynamisch erstellt und nicht persistent gemacht. 
Im folgenden werden Überweisungsdaten in der Datenbank abgelegt und später auch wieder 
ausgelesen.

7.1 Speichern in der Datenbank
Im ersten Schritt werden die eingegebenen Überweisungsdaten in einer einfachen Daten-
banktabelle gespeichert. Die hierzu erforderliche hsqldb-Datenbank ist für das Tutorial schon 
installiert und kann direkt verwendet werden.

➢ Fügen Sie zum Schreiben der Daten in die Klasse Banking folgenden Code ein:

...
import java.sql.Connection;
import java.sql.PreparedStatement;

import de.zeos.scf.service.InitialServiceConnector;
import de.zeos.zen.api.core.OperationRuntimeException;
...

public class Banking {

...

private static String dbPool = "test.store";
private static String stmt = "insert into entries " + 
"(account, bcode, text, amount, date) values (?,?,?,?,?)";

...

public static void book(Long account, Long bcode, Float amount, String text,
                        Date date) {
Connection con = null;
PreparedStatement prepStmnt = null;
try {
con = new InitialServiceConnector().getConnectionService().getConnection(dbPool);
prepStmnt = con.prepareStatement(stmt);
prepStmnt.setLong(1, account.longValue());
prepStmnt.setLong(2, bcode.longValue());
prepStmnt.setString(3, text);
prepStmnt.setFloat(4, amount.floatValue());
prepStmnt.setDate(5, new java.sql.Date(date.getTime()));
prepStmnt.execute();

} 
catch (Exception e) {
throw new OperationRuntimeException("Insert into 'entries' failed", e);

}
finally {
try {
if (null != prepStmnt)
prepStmnt.close();

if (null != con)
con.close();

}
catch (Exception e) { 
//jdbc error 

}
}

}

} // end of class Banking

Speichern Sie die Klasse. Der Java-Code ist sehr einfach gehalten und besteht im 
wesentlichen aus den notwendigen JDBC-Aufrufen, um die Werte in die Datenbank zu 
schreiben. Der Zugriff auf die Datenbank wird über den von der zen Platform zur Verfügung 
gestellten ConnectionService ermöglicht. Der Datenbankpool test.store für die 
Beispieldatenbank ist bereits vorkonfiguriert (in der Datei conf/scfservice.xml).

Bei Fehlern während des Datenbank-Zugriffs wird eine OperationRuntimeException 
geworfen. Diese veranlasst den Wechsel in den Fehlerzustand builtin:error.

➢ Aktivieren Sie nun die Business Logic View und klicken Sie in dieser auf den Reiter 
Workflow.

➢ Legen Sie mit dem Kontextmenü eine neue Operation an. Geben Sie als Description den 
Text buche in die Datenbank ein, als implementierende Klasse wählen Sie wieder 
Banking und schließlich die gerade erstellte Methode book.

➢ Ordnen Sie der Operation die Atome accountno, bankcode, amount, text und date (un-
terhalb der Composition transfer) in dieser Reihenfolge als Argumente zu (Ergebnis: 
siehe Abbildung 39).
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Diese Operation soll in unserem Beispiel immer dann aufgerufen werden, wenn der Nutzer 
das Überweisungsformular ausgefüllt hat und über die Action execute absendet. Aktivieren 
nun die Action View, um die neue Workflow Operation mit dieser Action zu verknüpfen.

➢ Selektieren Sie in der Action View die Action execute und öffnen Sie den Reiter 
Operations.

➢ Klappen Sie den Baum ganz auf, so dass Sie die soeben modellierte Operation sehen 
können.

➢ Diese fügen Sie nun der selektierten Action hinzu, indem Sie auf den Button mit dem Pfeil 
nach rechts klicken (Ergebnis: siehe Abbildung 40).

Dadurch wird nun jede einzelne Überweisungen in der Datenbank abgelegt.

7.2 Lesen aus der Datenbank
Für die Anzeige der getätigten Überweisungen wird die Anwendung nun noch einmal 
erweitert. Dabei werden die aus der Datenbank gelesenen Überweisungsvorgänge im 
Datenmodell gespeichert, um sie anschließend zur Anzeige zu bringen. Aktivieren Sie nun die 
Data Model View, um das Datenmodell um die dafür notwendigen Felder zu erweitern.

Datenmodell erweitern

Die Überweisungsvorgänge werden als Liste von einzelnen Überweisungen modelliert.

➢ Legen Sie hierzu auf der Composition account eine List an und nennen Sie diese 
entries.

Die Liste wird solange als fehlerhaft dargestellt, bis das Element definiert wird, aus dem die 
Liste bestehen soll.
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Abbildung 39
Business Logic View: Zuordnung der Argumente für die Operation „buche in die Datenbank“

Abbildung 40
Action View: Zuordnung der Operation zur Action „execute“



➢ Der neuen Liste fügen Sie nun eine Composition entry hinzu, die ihrerseits die Atome 
amount mit dem Datentyp Decimal with 2 digits precision für den Überweisungs-
betrag und text mit dem Datentyp String für den Überweisungstext enthält (Ergebnis: 
siehe Abbildung 41).

Workflow erweitern

Jetzt wird das Workflowmodell um die Anzeige der getätigten Überweisungen erweitert.

➢ Bereiten Sie dazu in der Action View eine Action mit dem Namen show vor.

➢ Zeichen Sie dann im zen Editor einen neuen State Node mit dem Namen transfers.

➢ Verbinden Sie menu und transfers mit einer Transition und legen Sie für diese Transition 
die Action show fest.

Der Nutzer soll von der Anzeige der Überweisungsliste auch wieder zurück zum Menü 
gelangen können.

➢ Ziehen Sie dazu eine Transition von transfers zurück zu menu. Diese Transition soll wie 
in den bisherigen Fällen die Action back nutzen (Ergebnis: siehe Abbildung 42).

Auf dem gerade erstellten State Node transfers sollen alle bereits getätigten Überweisungen 
angezeigt werden.

➢ Wechseln Sie dazu in die Data Model View und selektieren Sie den State Node 
transfers, um die Ausgabedaten für diesen State Node festzulegen.

➢ Aktivieren Sie auf der Liste der Überweisungen entries (unterhalb der Composition 
account) die Checkbox in der Spalte Out.

Da das Element entries nicht als In markiert wird, erscheinen die Überweisungen hier nur als 
Ausgabetext und nicht als Eingabefelder.
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Abbildung 42
Der vollständige Workflow der Tutorial-Anwendung

Abbildung 41
Data Model View: Erweiterung des Datenmodells für Persistenz



Java-Methode

Die Liste der Überweisungen ist bisher leer, da die Überweisungen bislang nur in der Daten-
bank abgelegt, aber noch nicht eingelesen wurden. Im folgenden werden die einzelnen Über-
weisungen eingelesen und ins Datenmodell geschrieben.

➢ Erweitern Sie die Klasse Banking um folgende Methoden, die die Überweisungsdaten aus 
der Datenbank auslesen.

...
import de.zeos.zen.api.fom.*;
import java.sql.ResultSet;
...

public static List readBookings() {
List buchungen = null;
Connection con = null;
PreparedStatement prepStmnt = null;
ResultSet rst = null;
try {
con = new InitialServiceConnector().getConnectionService().getConnection(dbPool);
prepStmnt = con.prepareStatement("select text, amount from entries");
rst = prepStmnt.executeQuery();
buchungen = createBookings(rst, "text", "amount", "entry", "entries");

} 
catch (Exception e) {
throw new OperationRuntimeException("Select on 'entries' failed", e);

}
finally {
try {
if (null != rst)
rst.close();

if (null != prepStmnt)
prepStmnt.close();

if (null != con)
con.close();

}
catch (Exception e) {
//jdbc error

}
}
return buchungen;

}

private static List createBookings(ResultSet rst, String textName, String amountName,
                           String entryName, String entriesName) throws Exception {
ElementBuilder builder = ElementBuilder.getInstance();
List entries = builder.newList(entriesName);
while (rst.next()) {

Atom text = builder.newAtom(textName);
text.setData(rst.getString(textName));

Atom amount = builder.newAtom(amountName);
amount.setData(new Double(rst.getDouble(amountName)));

// create composition of atoms
Composition entry = builder.newComposition(entryName);
entry.setElement(text);
entry.setElement(amount);

// add to List
entries.addElement(entry);

}
return entries;

}

Speichern Sie die Klasse. Diese Methoden lesen die Datenbanktabelle entries aus, erstellen 
für jeden Tabelleneintrag eine Composition entry und fügen diese der Liste entries hinzu. Die 
Methode readBookings wird nun wieder in der Business Logic View als Workflow Operation 
angelegt und mit dem Datenmodell verbunden.

➢ Erzeugen Sie dazu in der Business Logic View im Reiter Workflow über das Kontextmenü 
eine neue Operation.

➢ Geben Sie als Description den Text lese Überweisungen aus Datenbank ein und wählen 
Sie aus der Klasse Banking die Methode readBookings aus.

Diese Methode besitzt kein Eingabeargument, sondern nur die Liste der Überweisungen als 
Rückgabewert.

➢ Klappen Sie den Modellbaum so weit auf, dass Sie die Liste entries markieren können.

➢ Klicken Sie dann auf den unteren Button mit dem Pfeil nach rechts. Damit wird das 
Element als Rückgabewert zugeordnet.

Als letzter Schritt muss nur noch festgelegt werden, wann die soeben definierte Workflow 
Operation ausgeführt werden soll.
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➢ Aktivieren Sie hierzu die Action View, selektieren Sie die Action show und fügen der 
Action auf dem Reiter Operations die Operation lese Überweisungen aus Datenbank 
hinzu.

Dadurch wird diese Workflow Operation nun immer durch die Action show ausgelöst. Die 
bisher getätigten Überweisungen werden automatisch ins Datenmodell übernommen und an-
schließend auf dem State Node transfers angezeigt.

➢ Speichern Sie nun das Modell und testen Sie die neue Funktionalität (siehe Abbildung
43). In der installierten Datenbank sind schon zwei Buchungen eingetragen.

8 Schlußwort
Wir hoffen, dass wir im Rahmen dieses Tutorials zeigen konnten, wie man mit einfachsten 
Mitteln in kürzester Zeit eine Anwendung mit der zen Platform entwickeln, testen, anpassen 
und erweitern kann.

Dabei konnte natürlich nur ein kleiner Ausschnitt aus den umfangreichen Funktionalitäten 
der zen Platform gezeigt werden. Themen wie Integration, Lokalisierung, transparente 
Skalierung, Service-API oder variable Ein- und Ausgabe-Formate haben für dieses Beispiel 
noch keine Rolle gespielt.

Weitere Informationen zur zen Platform finden Sie im zen Platform Developers Guide. Hier 
sind alle Funktionalitäten soweit dokumentiert, dass sie selbständig integriert werden 
können.

Falls Probleme mit diesem Tutorial oder eigenen Anwendungen auftauchen oder Sie Fragen 
zur zen Platform haben, wenden Sie sich bitte direkt an support@zeos.de. Wir werden uns 
schnellstmöglich darum kümmern.
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Abbildung 43
Browser: Der State Node „transfers“



Anhang

A Weiterführende Dokumentation

I. zen Platform
Die ausführliche Dokumentation über die zen Platform finden Sie im zen Platform Developers 
Guide, der unter

http://www.zeos.de/support/download/zen-Developers-Guide.pdf

heruntergeladen werden kann.

II.Eclipse
Im Web existieren viele weitere Quellen mit zusätzlichen Tutorials und Dokumentation zu 
Eclipse. 

Eclipse Homepage (englisch)

Auf der Eclipse-Homepage finden sich alle Informationen zu Eclipse selbst und seinen Sub-
Projekten.

http://www.eclipse.org

Eclipse Project FAQ (englisch)

In der FAQ werden viele allgemeine Fragen rund um Eclipse beantwortet.

http://wiki.eclipse.org/index.php/Eclipse_FAQs

Eclipse Documentation (englisch)

Schnellzugriff auf die offizielle Eclipse-Dokumentation.

http://www.eclipse.org/documentation/main.html

Eclipse Community

In dieser Liste sind Links zu verschiedenen Webseiten der Eclipse-Community gesammelt, die 
weitere Dokumentation oder zusätzliche Plugins für Eclipse bereitstellen.

http://www.eclipse.org/community/plugins.php
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http://www.eclipse.org/community/main.html#EclipseInformation
http://www.eclipse.org/documentation/main.html
http://www.eclipse.org/eclipse/faq/eclipse-faq.html
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B FAQ - Häufig auftretende Fragen
Bitte beachten Sie auch die jeweils aktuellen Release Notes. Sie finden diese im Verzeichnis 
plugins/de.zeos.zenit.e3_2.x.y ihrer Eclipse-Installation.

Beim Starten der zen Engine sehe ich die Fehlermeldung: 
...java.net.BindException: Address already in use:8989 ... Deployment 
shutdown.

Q:

Vermutlich läuft die zen Engine bereits auf Port 8989, so dass ein erneuter Start nicht 
nötig ist. Sollten Sie trotzdem einen Neustart ausführen wollen, stoppen Sie die 
laufenden zen Engine zuvor. Siehe auch Kapitel   4.6  .
In seltenen Fällen kann es auch vorkommen, dass eine andere Software den Port 8989 
belegt. Sie können den zu verwendenden Port ändern, indem Sie in der Datei 
zen.properties im Ordner conf/ ihres Projektes den Schlüssel 
de.zeos.init.catalina.port ändern.

A:

Wenn ich Im zen Developer eine Eingabe tätige, wird der Wert nicht angenommen, 
sondern verschwindet wieder oder wird auf den vorherigen Wert zurückgesetzt.Q:
Ihre Eingabe war vermutlich nicht korrekt. Achten Sie bei Eingaben auf die Statuszeile 
am linken unteren Rand von Eclipse. Dort werden während der Eingabe, falls nötig, 
Fehlermeldungen angezeigt.

A:
Bei wiederholtem Testen zeigt der Browser immer wieder die gleiche Seite mit den 
gleichen Inhalten an.Q:
Sie haben vermutlich den „Back“ Button ihres Browsers verwendet. Um 
Datenkonsistenz zur gewährleisten, lässt die zen Engine nur modellierte Übergänge 
zu. Modellieren Sie zusätzliche Transitionen oder schließen und starten sie den 
Browser erneut, wenn Sie keine Navigation für Ihre Anwendung modelliert haben.

A:

Das Ergebnis im Browser fällt nicht so aus wie erwartet. Beschriftungen fehlen oder der 
Workflow ist nicht korrekt.Q:
Haben Sie die alle Änderung, auch in der Java-Klasse, abgespeichert?
Achten Sie beim Modellieren exakt auf die Anweisungen und die Groß-
/Kleinschreibung. Insbesondere die Fehler-Zustände builtin:error und builtin:timeout, 
die Label-Namen headline, label und error sowie die Rückgabewerte bei Decisions 
müssen in der angegebenen Groß- und Kleinschreibung eingegeben werden.

A:

Der Browser zeigt nur eine Fehlermeldung in der Art Keine Verbindung zu Rechner 
localhost (Port 8989) oder The connection was refused when attempting to 
contact localhost:8989 an.

Q:

Vermutlich läuft die zen Engine noch nicht. Starten Sie diese wie in Kapitel   4.6   Starten
und Testen des Modells beschrieben.A:
Im Browser erscheint ein Fehlerstate. Im Logoutput ein Fehlermeldung der Art: Error 
producing xml output!; nested exception is: No value found for resource 
'label' with locale 

Q:

Es wurden nicht alle Ressourcen in der benutzten Sprache erstellt/übersetzt. Stellen 
Sie im zen Developer am oberen Rand die gewünschte Locale ein und aktivieren Sie 
die Resource View. Alle Einträge bei denen ein <not localized> steht sollten 
übersetzt werden.

A:
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